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Class 1
Intro to HTML, CSS, and JavaScript 4

Administrative items
We will use the Zoom app for classes until further notice.

How to use Zoom for a virtual class room... be willing to share your screen...

I will need to see your code (from time to time)
My personal Nucamp site: http://www.drpage.net/nucamp/ .
Use it as an additional resource, and to download my lectures.

Today’s class is about HTML, but it is more than just that...

This Class covers Front End Development | Full Stack Development is next Semester

Multitier architecture
1 Front End \ Middle Tier Back End
Presentation tier Application tier Data tier
WebApp < | Database
HTML,CSS,JS ) _""'--—-5 Host Service SaL Query .~ Oracle
HTTP (Get/Post) | (GoDaddy AWS, exc.) }/" SalServer
7 M e MysaL
Mobile App | |HTTP (Get/Postl | File Server NosaL
HTML,C55,15 Mode.js {MongoDB)
.Net/cC#
jQuery / Bootstrap PHP, JAVA

We will cover: Setting up your files, your IDE, how to use VS Code, how Web pages are laid out, important tags (and their attributes), how
HTML interacts with CSS and JavaScript, as well as your Week 1 Class Assignment for this week.

Getting started: Create (or open) a Folder called “Nucamp” on your desktop (or somewhere you remember).
Add these sub-folders: “Class1”, “Class2”, “Class3”, “Class4”, “images”, “css”, (“videos” or “music” or “media”) and “js” <= stay organized.
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Setting up your PC or MAC with MS VSCode Code <= use these
instructions. — Everyone needs to have VSCode running...
Everyone please acknowledge. Are you using a PC or MAC ?

MS VSCode: An integrated development environment (IDE) is
software that you can load onto your computer, designed to streamline
web development. Visual Studio Code, Eclipse, Dreamweaver, and
Aptana, Notepad++ ... to name a few...

Nucamp
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Things worth dicussing...

URL Universal or Uniform Resource Locator

IP Address A numerical label assigned to each device connected to a computer network.

+port 80 URLs process requests via a Domain Name Server (DNS) converts to IP address.
Hosting services use the ICANN database, which keeps track of domain names.

ISP Internet Service Provider

Hosting Service

GoDaddy, Web.com, HostGator,

HTTP

A protocol used mostly for browsing the internet

HTTPS

Encrypted

FTP

File Transfer Protocol (SMTP, POP3 or IMAP4 for sending & retrieving emails)



http://www.drpage.net/nucamp/
https://learn.nucamp.co/mod/book/view.php?id=10
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1) Open a folder in VSCode: File => Open a Folder, then choose Nucamp (or your main folder) from the dialog box. (Don’t open a file only)
ﬂ
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2) After selecting the folder, your IDE should look something like this... Showing the Nucamp folder and 8 sub-folders

¥ File
N

Jo
%
@ -

[" > js

Edit Selection View Go Debug Terminal Help Nucamp - Visual Studio Code

EXPLORER

' OPEN EDITORS
» NUCAMP
> Classl
> Class2
> Class3
> Class4
> css
>

> videos

3) Create a new HTML file. From the menu select: File => New File

o

File Edit Selection WView Go Debug Terminal

MNew File Cirl+N

Help

Mew Window Ctri+5hift+M
Open File... Ctrl+0O
Open Folder... Ctrl+K Cirl+O

Open Workspace...

Open Recent p

Add Folder to Workspace...

Save Workspace As...

4) You should see an Untitled file:

Notice the VSCode short cuts... They
will come in very handy as you start
developing your code... More about
them when we create a file...
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File Edit Selechon WView Go Debug Temnal Help

Untitled-1 X Alternate Method: Click the New o
H H H H “ OPEN EDITORS
~ OPEM EDITORS 1 File |co_n, an_d Just ‘t‘ype 'rlthe name vae. B L &
% = intited1 of the file with an *.html” extension. e
> Class2
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5) Before creating any code you need to name the file with the HTML extension. File > Save As, then in the dialog box give the file a
File Name: something like “home” (no spaces... use Camelback or Underlines — but no spaces. Servers don’t like names with spaces)
then select HTML from the “Save As Type” dropdown list

30 File Edit Selection View Go Debug Terminal Help Untitled-1 - Nucamp - Visual Studio Code
EXPLORER Untitled-1 X
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“i H°rd“egr°“‘° | images §/27/2020 9:23 M |
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> JS Save as type: |HTML (= html;* htm;*.shtml; = xhtml; = mdoc; = jsp; *.asp; = aspx; *.jshim; * volt) j
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> videos ce=g

C++ (*.cpp; ™. oy ®. 000 . hppy ®.hh;y = oo *. b .0, *.ino; *.inl)
C# (*.cs;%.cax; ™. cake)
C55 (*.cs8)
-l Dockerfile {*.dockerfile)
M Fa# (=.fs; ™. fsi;*. fsx; = fsscript)
Diff (*.patch; = diff; =.rej)
Go (*.go)
Groovy (*.groovy;*.gvy;*.grade)
Handlebars (* handlebars; *.hbs; . his)
HLSL (*.hlsl: . hlsli;®, fi; *. fich: *. vsh: *.psh; *, cginc: *. compute
HTML {* himl; * him; *.shiml; . xhiml; *, j
Ini (*.ini)
Properties (*.properties; *.cfg;*.conf; ®.directory)
Java (*.java;*.jav)
JavaScript React (*.jsx)
JavaScript (*.js; *.es6;*.mjs; *.pac)
JSON (*.json; . bowerrc; = jshintre; * jscsre; . swerc; ®.webmanifest; . js.map; *. css.map)
Less (*.less)
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6) Select Save, and you should see the following:
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Go Debug Terminal Help

<» Class1Assignmenthtml X

Class1 > <> Class1Assignment.html

1

Class1Assigr

6a) At this point you could start typing
code or paste code from another file, but
there is a quick short cut... hold down the

Go Debug Terminal

“Shift” key + ! and you will get an
Emmet dialog box with all necessary
base code for an HTML page.

Help » Class1Assignment.htm! - Nucamp - Visual Studio Code

<> Class1Assignment.html @

Class1 » <> Class1Assignment.html

1
3
£

Emmet Abbreviation

<IDOCTYPE html>
<html lang="en">
<head>
<meta charset="UTF-8">
<meta name="viewport"
content="width=device-width, initial-scale=1.0">
<meta http-equiv="X-UA-Compatible”
content="ie=edge">
<title>Document</title>
</head>

6b) Select the first level of “Emmet Abbreviation” and you should see a basic HTML page

Preferences >

)G File Edit Selection View Go Debug Terminal Help « Class1Assignment.htm| - Nucamp - Visual Studio Code
EXPLORER ¢» ClasslAssignment.html @ 38 TBEl ot sascon view on run
“ OPEN EDIT... | 1UNSAVED| Classl > <> ClasslAssignmenthtml > & html > & body ew File
® ¢ (ClasslAssignment... 1 <!DOCTYPE html>
« NUCAMP 2 <html lang="en">
~ Class1 3 <head> . 5
<> Class1Assignment.ht N ¢meta charset="UTF-8"
== 5 <meta name="viewport" content="width=device-width, initial-scale=1.0">
> Class2 3 <meta http-equiv="X-UA-Compatible"” content="ie=edge">
> Class3 7 <title>Document</title>
> Class4 8 </head>
S css 9 <body >
> images 18
> is 11 </body>
s 12 </html>

videos

7) Do a quick save (Ctrl + s), and now let’s talk code...

Terminal Help Keyboard She

[ ] Eeyboard S

Keyboard Shortouts Cirl+K Cirl+ S

(Auto Format: Alt + Shift + f)... See All Shortcuts: https:l/Nsﬂéldde-shortcdfs‘.com



https://vscode-shortcuts.com/
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HTML is a markup language... That’s how it gets its name: HyperText Markup Language... (Kind of like how a publisher marks up a
manuscript before sending it to the printer: What goes where, what kind of font, how large the type should be, images, color...and so on...)

You can build an entire web site using only HTML (in fact, that’s the way we used to do it... way back when things were just starting up on the
internet).

There are a lot of HTML tags, but you really don’t have to know them all... (Just know how they work and how to find them).
However, there are several tags (elements) that you need to know. (Rem: all tags start and end with “angle brackets”: “<” and “>”

First, you need to know the structure/syntax of HTML tags
o HTML tags generally have both a start and end tag: (i.e., <p> </p>), butnotall do: <img src="x.jpg"/> (void, non-closing self-closing, binary)

« Everything between a start and end tag, including both the start and end tag, are considered an Element.

<div id="Home"> Here is a <div> element with an <hl >and a <p> element(s) embedded in it...
<h1>Home</h1> The <h1> element has “Home” embedded within it...
<p>Lorem ipsun</p> The <p> element has “Lorem ipsum’ embedded within it...

</div>

e HTML is not case-sensitive, but it should be... keep to one case - to be sure that CSS, and JS don’t get confused (lower case is best).
e HTML tags have attributes, which tell the tags how to act. Many attributes are deprecated, and superseded by CSS,
but some attributes are important: Such as “src” for images, “action” and “method” for forms, and “href” for anchors (links), to name a few.

Side Note:

The importance of proper indenting of code
Code can get very messy... And although you can write an HTML page without any code indentation at
all... it will be almost impossible to read. It is best practice to start clearly indenting your code as you
write it... Use the auto-complete tools in VSCode as well.

(Auto Format: Alt + Shift + )

Fun Facts...Domains (web sites use a domain to represent an IP) [and you have one: Localhost (127.0.0.1)] use Live Server [y
(For now, we will work with our Localhost...but know how to work with a domain...).
Registering a Domain

Method 1: With a Hosting Service Remember: Domain name (google.com) is the registered address
Method 2: Without a Hosting Service of your website and maps to an IP address (172.217.6.206) on the
https://www.wikihow.com/Register-a-Domain-Name host server. (Shared IP’s vs. Dedicated IP’s)

Ok... back to HTML...

Some Tags (Elements) you need to know:


https://www.w3schools.com/TAGs/
http://www.drpage.net/WebA08/L030_NiteLifeSite/Banner3.jpg
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Tags (AKA: Elements) — As noted above, many Tags (by classification) are also Elements (these terms are often interchanged)...
The <ipoctyee htmi> tag: This tells the browser what DTD to use (There is a Document Type Definition DTD that the browser uses — W3C)
The <«htm1> tag: This tells the browser you are using HTML as opposed to XML or XHTML.... You can add an attribute like language.
The <head> tag: This element holds non-visible (meta data) information - such as your page title and meta data
The <titlesMy Home Page</titlestag: Used for improving user experience and SEO. Also what the user sees in the browser tab...
The <1ink> tag: Used to link to external style sheets. Need an href, and rel <1ink rel="stylesheet" type="text/css" href="theme.css">
The <1ink> tag is also used for Favicons (size 16x16, 32x32 / ico, gif, jpg): <link rel="icon" href="../images/ben.ico" type="image/x-icon">
The <meta> tag: Various meta tag attributes tell the browser key information such as the character set, or a page's dimensions and scaling,
but are also used for SEO, and even redirection (Don’t need to memorize these... just know what they do, and how to find them)

O <meta charset="UTF-8"> In the beginning (1963), there was only ASCII (128 char then 256). UTF-8 unicode Transformation Format came 1992 1m+.

<meta name="viewport" content="width=device-width, initial-scale=1.0">
Below are other useful Meta tags

<meta name="description" content="Free Web tutorials"> Search Engine Optimization (SEO)
<meta name="keywords" content="HTML,CSS,XML,JavaScript"> SE0

O O 0O 0O 0O

<meta http-equiv="Cache-Control" content="no-cache" /> no caching of page

o There are many more meta tags... see Head and Body elements.html or W3Schools
The <body> Element: The head holds the visible information that is seen by the user

<meta http-equiv="refresh" content="5;URL=http://google.com"> 5 second wait.. then off to google

viewport adjusts with the device

SEO

Search Engine Optimization
is the process of improving the
quality and quantity of website
traffic to a website or a web page
from search engines.

The <a href="http://drpage.net/nucamp/index.html">Dan's Nucamp Page</a> Anchor tag: REM: the href attribute is required (target)
The <img src="MyLife.jpg" height="108" alt="banner" > Image tag: REM: the src attribute is required. The alt attribute is important.
The <form action="results.html" method="get">Form tag: REM: the action and method attributes are required — used for passing user
information to the server (middle tier and/or backend). Multiple Child tags. Discussed in detail next week

<input type="text or number or checkbox or radio or file or submit...”> |, <textarea>, <select> &<option> , <button> and more...

The <p> Loren ipsum </p> Paragraph element: block tag for large amounts of text
The <h1> Lorem ipsum </h1> Heading elements: hl — h6 block tags used for heading text
The <div> Lorem ipsum </div> Division tag: block element used for HTML structure
The <span> Lorem ipsum </span> Span tag: non-block element used for formatting
The <u1> unordered list, and the <o1> Ordered list tags: bullet point lists and numbered lists
0 The child <1i> List Item tag: used with the <u1>, and the <o1> tags: to show each list item
The <table> with rows <tr> and cells <td> (discussed below)
Two more tags
The <style></style>tag: used for CSS
The <script></script>tag: used for JavaScript

HTML Element Reference - By Category

w3schools.com
https://iwww.w3schools.com/tags/ref_byfunc.asp

<div> Defines a section in a document

<span> Defines a section in a document

<header> Defines a header for a document or section
<footer> Defines a footer for a document or section
<main> Specifies the main content of a document
<section> Defines a section in a document

<article> Defines an article

<p> Defines a paragraph

There are others that you may want to look at... see Head and Body elements.html or W3Schools

There are special characters that are used in HTML for things like copyright, and math symbols -

https://www.w3schools.com/html/html symbols.asp
The <!-- comment --> tag is used for comments



https://websitesetup.org/favicon-generator/
http://www.drpage.net/nucamp/7%20Head%20and%20Body%20elements.html
https://www.w3schools.com/TAGs/tag_meta.asp
http://www.drpage.net/nucamp/7%20Head%20and%20Body%20elements.html
https://www.w3schools.com/TAGs/tag_link.asp
https://www.w3schools.com/html/html_symbols.asp
https://www.w3schools.com/tags/ref_byfunc.asp
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Attributes

All HTML Tags allow attributes. Attributes modify the default behavior of an element. Order of attributes does not matter.
Attributes are generally all name-value pairs (although a few are binary and just default to the true value).
There are lots of attributes, many are deprecated, or rarely used, but here are a few you should know...

Web Content Management Systems (CMS)

MS SharePoint

Microsoft Sharepoint, a web-based
collaborative platform, to provide
business intelligence analytics and
reporting. They can provide Bl content
such as data connections, reports,
scorecards, dashboards, and more. You
need to set up your hosting and domain
name.

Wordpress.org

WordPress.org is our number one choice
for the best CMS platform. It's the world's
most popular CMS software, and it
powers around 35% of all websites on the
internet

WordPress.com

WordPress.com is the commercial, hosted
version of WordPress. With
WordPress.com, you get an all-in-one
CMS platform that's hosted for you. You
can purchase a domain name or use a free
subdomain with branding.

Drupal Drupal is a free, open-source content
management system written in PHP that
competes primarily with Joomla and
Plone.

Joomla Joomla is another popular free open

source CMS platform that comes with lots
of different templates and extensions.
It's free to use, but you'll need hosting
and a domain name.

Salesforce CMS

Salesforce CMS is a hybrid CMS, which
means your teams can create content in a
central location, and syndicate it to any
digital touchpoint, whether it's an
experience is powered by Salesforce or
another system

Identifiers
id id="myIDValue" adds a unique ID for an element
class class="myClassValue" creates a relation between elements and stylesheets
name name="myNameValue" Specifies the name of the element (forms and iFrames)
CSS
style style="background-color: black; " provides inline styling for an element
Hyperlinks
href href="https://www.nucamp.co/" adds a URL destination for a link, creating a hyperlink
Images
src src="image.png" defines an external source for an element
width width="100" changes the element's dimensions
height height="100" changes the element's dimensions
alt alt="Image name" text displayed if element (image) cannot be loaded
Meta
charset charset="UTF-8" Describes metadata
content content="My Web Site" Describes metadata
Deprecated
bgcolor bgcolor="#000000" Specifies the background color of an element
color color="#ffffff" Specifies the text color
Forms
checked checked (boolean) Specifies that an <input> element is pre-selected
for for="male" Specifies which form element a label is bound to
required required (boolean) Specifies that an <input> element is required
value value="click me" Specifies the value of the element
Scripting
onload="myScript()"
on... trigger onclick="myScript()" etc. Script to be run

Adobe
Experience
Manager

Adobe Experience Manager is a hybrid
CMS, giving the flexibility to be used asa
traditional CMS or headless CMS. A
headless CMS is a content management
system that provides a way to author
content as data over an API
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Wow... Time to build a Web Page — Week 1 Class Assignment

First we need to do our Week 1 - Nucamp In-Class Assignment - Profile Basic Web Page Instructions. Link to instructions

.
.
.
.

My

My Profile Page

About Me

Born in Beston

[ lived in Philadelphia

I like HTML

I enjoyved writing the Constitution

Interests
Writing

Politics
Flyving Kvtes

A Song Just for vou

p 0:00/73:58 4

Get this and other Free MP3's Here

Dan's Page

A few HTML Tags that may be useful (but are mostly deprecated) for this assignment...
The <b></b> tag specifies bold text.

The <blockquote><blockquote> tag - Browsers usually indent

The <br/> tag inserts a single line break

The <center></center> tag was used to center-align text

The <em></em> and <i></i> tag is used to define (italic) emphasized text.

The <font></font> tag was used to specify the font face, size, and color of text.
The <hr/> tag defines a thematic break (as a horizontal rule)

The <strong></strong> tag is used to define important or bold text

The <sub></sub> tag defines sypscript tEXL.

The <sup></sup> tag defines SUPErSCrPt gaxt

Special Characters

© &copy; Copyright

® &reg; Registered Sign

™ &trade; Trademark

space &nbsp; Non-breaking Space - HTML does not recognize more than one space
<> &lt; &gt; Less Than and Greater Than signs (for math...)

There are a whole lot more ... Search for “html special characters”... or go here
https://html-css-js.com/html/character-codes/html4/

Git An open-source version control system

GitHub A website and cloud-based service that helps developers store and manage
their code, as well as track and control changes to their code.
It handles Version Control for code changes (merging and branching of
developers code)

Save Your File!'! (Ctrl +s). You will need to turn it in (submit it) by Monday COB.



http://www.drpage.net/nucamp
https://html-css-js.com/html/character-codes/html4/
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Now for some fun with just HTML
Building a simple one-page Web Site (Note: This is not required, but you might enjoy doing the code...)

Aside from just building a basic HTML page in our first “Week 1 Workshop Assignment”, you may also want to develop (design) a single-page,
four section, website using a simple image-link menu and an iframe. Below is the basic design (structure) of many web pages. You can build a

page with pure HTML... (Ves... Just for today... we will only use HTML... Normally we would use HTML, + CSS, and JavaScript).

(1) Header

1 My Life

(2) Menu: Home About Assignment Contact

(3) Content container
(Actually contains 4 parts)

Home
About
Week 1 Assignment —
Contact ' = '?]H LT
8 " " [ i 1l
L
(4) Footer

Create a new HTML Page in VSCode (name it index.html, or anything you like... but no spaces in the name)
Things you need:
e A Header Image: http://drpage.net/nucamp/images/MyLife.jpg (or use your own image — search on panoramic views)

Another Side of

My Life
e Four button images

I
(or make your own)

e lorem ipsum ftext:

Lorem ipsum dolor sit amet, consectetur adipisci elit, sed eiusmod tempor incidunt ut labore et Notes

dolore magna aliqua. Ut enim ad minim veniam, quis nostrum exercitationem ullam corporis e The use of the body tag attribute for color. bgcolor="#fdaasf"
suscipit laboriosam, nisi ut aliquid ex ea commodi consequatur. Quis aute iure reprehenderit in e The height attribute for the image tag

voluptate velit esse cillum dolore eu fugiat nulla pariatur. Excepteur sint obcaecat cupiditat non »  The use of the Font tag for size and color of the h1 tag content
proident, sunt in culpa qui officia deserunt mollit anim id est laborum. e The align attribute for the h3 tag



https://learn.nucamp.co/mod/assign/view.php?id=1462
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Cheap Tricks: A web page using only HTML with tables.
This is how it was done in the old days... but it is worth knowing (LOL)

But Don’t Do This In Front Of Your Boss!

Open a new HTML file called: index.html

To create the page, select the first level of “Emmet
Abbreviation” (Shift + ).

In the head you can add a favicon if you like.

Also add an appropriate title...

In the body:

Set the body background “bgcolor” attribute to a

variation of SandyBrown: #fdaa4f

Build the following parts (elements) of the page:
<header></header> We will add an image in

this element.
<menu></menu> We will add an image-links here
<main></main> This element is for our content.
<footer></footer>We will add a © copyright.

<!DOCTYPE html>
<html lang="en">
<head>
<meta charset="UTF-8">
<meta name="viewport" content="width=device-width, initial-scale=1.0">
<link rel="icon" href="http://www.drpage.net/nucamp/images/dp.gif" type="image/gif">
<title>My Life</title>
</head>
<body bgcolor="#fdaadf">
<header></header>
<menu></menu>
<main></main>
<footer></footer>
</body>
</html>

Go ahead and add an image in the header element.

A word on Absolute Vs. Relative addresses:

To get from your html page to your images folder you
need to navigate up to your root directory (unless your
images folder is in your classl folder). To navigate up
one level to your root folder, in the src attribute type

“ ../ 7, orinside your Class folder type “ ./ ”

In VS Code auto complete will help you find the folder
and file you are looking for...

An Absolute address will contain the entire URL:
http://www.drpage.net/nucamp/images/MyL.ife.jpg

Both work, but get familiar with using relative paths.

In the footer, add a © copyright. See the notes
above for special characters. &copy;
Next we will work on the menu & main elements...

<IDOCTYPE html>
<html lang="en">
<head>
<meta charset="UTF-8">
<meta name="viewport" content="width=device-width, initial-scale=1.0">
<link rel="icon" href="http://www.drpage.net/nucamp/images/dp.gif" type="image/gif">
<title>MyLife</title>

</head>
<body bgcolor="#fdaadf">
<header>
<img src="../images/MyLife.jpg" id="top" width="100%" alt="banner">
</header>
<menu></menu> <!-- do this next -->
<main></main> <!-- do this next -->

<footer align="right" >
<font color="#ffffff">
<br>&copy;MyLife 2021 &nbsp; &nbsp; &nbsp; &nbsp;
</font>
</footer>
</body>
</html>
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The menu & main elements are tied together by
image-links which interact with an iFrame.

The Inline Frame element <iframe> represents
external content embedded in another HTML page.
Created by Microsoft in 1997 - incorporated by all
browsers by 2000.

iframe Attributes:

e The src attribute defines the URL of the page to embed

e The height and width attributes to specify the size of
the iframe, specified in pixels or % .

e The name attribute is used in the target attribute of

the <a> elements </a>
e The scrolling and frameBorder attributes are optional | </menu>
for enhanced user experience.
<main>

Alternatives to the iframe are: embed and object tags
<embed type="text/html" src="content1.html"width

<menu align="center">

<a href="contentl.html#home" target="content">
<img src="../images/Home.jpg" alt="Home">

</a> &nbsp; &nbsp; &nbsp;

<a href="contentl.html#about" target="content">
<img src="../images/About.jpg" alt="About">

</a> &nbsp; &nbsp; &nbsp;

<a href="contentl.html#assignment" target="content">
<img src="../images/Assignment.jpg" alt="Assignment">

</a> &nbsp; &nbsp; &nbsp;

<a href="contentl.html#contact" target="content">
<img src="../images/Contact.jpg" alt="Contact">

<iframe src="contentl.html" width="100%" height="450"
scrolling="yes" name="content" frameBorder="0" >

="100%" height="500" name="content"> </iframe>
</main>
The inline frame (iFrame) is used to embed an HTML document within another HTML document. J File Edit Selection View

The source document we will embed is content1.htm1

The image-links will use this file as their href=>> attribute value.

Notice that iFrames also make use of Bookmarks to jump to a specific location in the embedded file.

href="contentl.html#home"

Take a look at the contentl.html file below. The contentl.html file is separate file from the index.html file.
Create a new HTML file named content1.html in the same folder as your index.html file.

A note on the Target attribute: the target attribute specifies where to open the linked document.
Primarily used with <a> anchor tags and <form> tags (but also with <area> and <base> tags)

EXPLORER

> OPEN EDITORS

vans. T B O &
v Classl
<> contentl.html
<> index.html

<> profile_Ben.html

<base> Specify a default URL and default target for all links on a page:

_blank Opens the linked document in a new window or tab chead> it/ /g . " tareete blank”
_self (default) Opens the linked document in the same frame as it was clicked </;e23§ refrhttp://drpage.net/nucanp/" target="_blank">
_parent Opens the linked document in the parent frame — not used much (old Frame days) <body>

_top Opens the linked document in the full body of the window — not used much <img src="images/home.gif" width="24" height="39">

iFrameName Opens the linked document in the named iframe

<a href="Classl/MyLife.html">HTML base Tag</a>
</body>
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Give each section tag an id attribute that
correlates to the bookmark in the anchor tag,

Notice the use of tables to structure the image
and text content of each section

The Table element
A table is an element made up of rows and
columns.

We will build our table manually, but you could
also use a table generator...
(http://www.drpage.net/nucamp/CodeGenerator_WYSIWY G.html)

NOTE: Tables should be used for tabular data —
this is what they are designed for. But in the past, a
lot of people used tables to lay out web pages, (e.g.
one row to contain the header, one row to contain
the content columns, one row to contain the footer,
etc.). And you still see it occasionally...

The Table <table></table> tag is the parent
element.

The first child of a table is the Row <tr></tr>
(aka: table row)

The Row <tr> has its own child — The Cell (aka:
table data) <td></td>

You can have as many rows and cells as you like...
There is also a Table Heading row. Mostly used for

first table row. <th></th> (we won’t use it)

Table Attributes:

Attribute Description Syntax Example
used to specify
border around the

Border table & cells border="2"
specify amount of

Cell spacing between

Padding border and cell cellpadding="5"

<!-The content is embedded - it does not need head or body elements -->
<section id="home">
<h2>Home</h2>
<table>
<tr>
<td>
<font color="#fdaadf">
<img src="../images/bridge.jpg" alt="bridge" height="375" align="left">
HOME Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor inc
ididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercit
ation ullamco laboris nisi ut aliquip ex ea commodo consequat.

</font>
</td>
</tr>
</table>
<hr>
</section>
<section id="about">
<h2>About</h2>
<table>
<tr>
<td>
<font color="#fdaadf">
<img src="../images/tree.jpg" alt="Tree" height="375" align="right">
About Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor in
cididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exerci
tation ullamco laboris nisi ut aliquip ex ea commodo consequat. Duis aute irure dolor i
n reprehenderit in voluptate velit esse cillum dolore eu fugiat nulla pariatur.
</font>
</td>
</tr>
</table>
<hr>
</section>
<section id="assignment">
<h2>Assignment</h2>

<table align="center"><tr><td >
<iframe src="http://drpage.net/nucamp/Classl/profile_Ben.html" width="500" height="400"
scrolling="yes" frameborder="0"></iframe>
</td></tr></table>
<hr>
</section>
<section id="contact">
<h2>Contact</h2>
<table>
<tr>
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content.
specify amount of
Cell spacing between two
Spacing adjacent cells. cellspacing="3"
used to set the width
Width of the table. width="80%"
used to set the
alignment of table
align horizontally. align="centre"
used to set the
background color of
bgcolor the table. bgcolor="blue"
used to set image in
the table
background | background. background="image.jpg"
Copy the code and add it to your
contentl.html file

<td>
<img src="../images/joanne.jpg" alt="Joanne" height="375">
</td>
<td align="center" valign="top" width="25%">
<font color="#fdaadf">
12707 Northeast 30th Street <br>
Bellevue, WA 98005<br>
United States
</font>
</td>
</tr>
</table>
</section>

Putting it all together...

If you run the code as it is it will work, but
depending on screen resolution, the page may get
a little jumpy, an is not well aligned.

So, an old trick to center an purely HTML page
is to add a table around all of the body content..

<body bgcolor="#fdaa4f">
<table align="center" bgcolor="#000000" cellspacing="0" cellpadding="0"><tr><td>
<header>
</footer>
</td></tr></table>

</body>

<IDOCTYPE html>
<html lang="en">
<head>
<meta charset="UTF-8">
<meta name="viewport" content="width=device-width, initial-scale=1.0">
<link rel="icon" href="http://www.drpage.net/nucamp/images/dp.gif" type="image/gif">
<title>MyLife</title>
</head>
<body bgcolor="#fdaadf">
<table align="center" bgcolor="#000000" cellspacing="0" cellpadding="0"><tr><td>
<header>
<img src="../images/MyLife.jpg" id="top" width="100%" alt="banner">
</header>
<menu align="center">
<a href="contentl.html#home" target="content">
<img src="../images/Home.jpg" alt="Home">
</a> &nbsp; &nbsp; &nbsp;
<a href="contentl.html#about" target="content">
<img src="../images/About.jpg" alt="About">
</a> &nbsp; &nbsp; &nbsp;
<a href="contentl.html#assignment" target="content">
<img src="../images/Assignment.jpg" alt="Assignment">
</a> &nbsp; &nbsp; &nbsp;
<a href="contentl.html#contact" target="content">
<img src="../images/Contact.jpg" alt="Contact">
</a>
</menu>
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<main>
<iframe src="contentl.html" width="100%" height="450"
scrolling="yes" name="content" frameBorder="0" >
</iframe>
</main>
<footer align="right" >
<font color="#ffffff">
<br>&copy;MyLife 2021 &nbsp; &nbsp; &nbsp; &nbsp;
</font>
</footer>
</td></tr></table>
</body>
</html>

Left Menu

Of course you could do the whole thing with a left side menu too...

This time set the page up with only header, main,
and footer elements

<!DOCTYPE html>

<html lang="en">

<head>
<meta charset="UTF-8">
<meta name="viewport" content="width=device-width, initial-scale=1.0">
<link rel="icon" href="../images/dp.gif" type="image/gif">
<title>My Life - HTML Only</title>

</head>
<body bgcolor="#fdaadf"><!-- rgb( 253, 170, 79) is not supported -->
<header>
<img src="../images/MyLife.jpg" id="top" width="100%" alt="banner">
</header>
<main></main> <!-- do this last -->

<footer align="right" >
<font color="#ffffff">
<br>&copy;MyLife 2021 &nbsp; &nbsp; &nbsp; &nbsp;
</font>
</footer>
</body>
</html>
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Then for the main element, add a table with one
row and two cells...

Use the same iFrame with the source of
contentl.html

<main>
<tabﬁor‘der‘="0" width="100%" bgcolor="#000000">
<td width="20%" valign="top" align="center">
<h1>Menu</h1>
</td>
<td width="80%">
<iframe src="contentl.html" width="100%" height="500"
scrolling="yes" name="content" frameBorder="0" >
</td>
</table>
</main>

For the menu,

In the first table cell, set the cell width to 20%,
With vertical alignment to top, and horizontal
alignment to center...

Then just replace the &nbsp; code with <br>
break tags <br/>

Now it should work the same...

<main>
<table border="0" width="100%" bgcolor="#000000">
<tr>
<td width="20%" valign="top" align="center">
<h1>Menu</h1>
<a href="contentl.html#home" target="content">
<img src="../images/Home.jpg" alt="Home">
</a><br>
<a href="contentl.html#about" target="content">
<img src="../images/About.jpg" alt="About">
</a><br>
<a href="contentl.html#assignment" target="content">
<img src="../images/Assignment.jpg" alt="Assignment">
</a><br>
<a href="contentl.html#contact" target="content">
<img src="../images/Contact.jpg" alt="Contact">
</a>
</td>
<td width="80%">
<iframe src="contentl.html" width="100%" height="500"
scrolling="yes" name="content" frameBorder="0" >
</iframe>
</td>
</tr>
</table>
</main>
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Completed Code index.html

<!DOCTYPE html>
<html lang="en">
<head>
<meta charset="UTF-8">
<meta name="viewport" content="width=device-width, initial-scale=1.0">
<link rel="icon" href="http://www.drpage.net/nucamp/images/dp.gif" type="image/gif">
<title>MyLife</title>
</head>
<body bgcolor="#fdaadf">
<table align="center" bgcolor="#000000" cellspacing="0" cellpadding="0"><tr><td>
<header>
<img src="../images/MyLife.jpg" id="top" width="100%" alt="banner">
</header>
<menu align="center">
<a href="contentl.html#home" target="content">
<img src="../images/Home.jpg" alt="Home">
</a> &nbsp; &nbsp; &nbsp;
<a href="contentl.html#about" target="content">
<img src="../images/About.jpg" alt="About">
</a> &nbsp; &nbsp; &nbsp;
<a href="contentl.html#assignment" target="content">
<img src="../images/Assignment.jpg" alt="Assignment">
</a> &nbsp; &nbsp; &nbsp;
<a href="contentl.html#contact" target="content">
<img src="../images/Contact.jpg" alt="Contact">
</a>
</menu>
<main>
<iframe src="contentl.html" width="100%" height="450"
scrolling="yes" name="content" frameBorder="0" >
</iframe>
</main>
<footer align="right" >
<font color="#ffffff">
<br>&copy;MyLife 2021 &nbsp; &nbsp; &nbsp; &nbsp;
</font>
</footer>
</td></tr></table>
</body>
</html>
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Completed Code contentl.html

<!-- content is embeded - it does not need head or body elements -->
<section id="home">
<h2>Home</h2>
<table>
<tr>
<td>

<font color="#fdaadf">
<img src="../images/bridge.jpg" alt="bridge" height="375" align="left" hspace="5">
HOME Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna
aliqua. Ut enim ad minim veniam, quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat.
</font>
</td>
</tr>
</table>
<hr>
</section>
<section id="about">
<h2>About</h2>
<table>
<tr>
<td>
<font color="#fdaadf">
<img src="../images/tree.jpg" alt="Tree" height="375" align="right">

About Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magn
a aliqua. Ut enim ad minim veniam, quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat. Duis aute irure dolor
in reprehenderit in voluptate velit esse cillum dolore eu fugiat nulla pariatur.
</font>
</td>
</tr>
</table>
<hr>
</section>
<section id="assignment">
<h2>Assignment</h2>
<table align="center"><tr><td >
<iframe src="http://drpage.net/nucamp/Classl/profile_Ben.html" width="500" height="400" scrolling="yes" frameborder="0"></iframe>
</td></tr></table>
<hr>
</section>
<section id="contact">
<h2>Contact</h2>
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<table>
<tr>
<td>
<img src="../images/joanne.jpg" alt="Joanne" height="375"><br><br><br><br><br><br>
</td>
<td align="center" valign="top" width="30%">
<font color="#fdaadf">
12707 Northeast 30th Street <br>
Bellevue, WA 98005<br>
United States

</font>
</td>
</tr>
</table>
</section>

Completed Code index2.html

<IDOCTYPE html>
<html lang="en">
<head>
<meta charset="UTF-8">
<meta name="viewport" content="width=device-width, initial-scale=1.0">
<link rel="icon" href="http://www.drpage.net/nucamp/images/dp.gif" type="image/gif">
<title>MyLife</title>
</head>
<body bgcolor="#fdaadf">
<table align="center" bgcolor="#000000" cellspacing="0" cellpadding="0"><tr><td>
<header>
<img src="../images/MyLife.jpg" id="top" width="100%" alt="banner">
</header>
<menu align="center">

</menu>
<main>
<table border="0" width="100%" bgcolor="#000000">
<tr>
<td width="20%" valign="top" align="center">
<h1>Menu</h1>
<a href="contentl.html#home" target="content">
<img src="../images/Home.jpg" alt="Home">
</a><br>

<a href="contentl.html#about" target="content">
<img src="../images/About.jpg" alt="About">
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</a><br>
<a href="contentl.html#assignment” target="content">

<img src="../images/Assignment.jpg" alt="Assignment">
</a><br>

<a href="contentl.html#contact" target="content">
<img src="../images/Contact.jpg" alt="Contact">
</a>
</td>
<td width="80%">
<iframe src="contentl.html" width="100%" height="500"
scrolling="yes" name="content" frameBorder="0" ></iframe>
</td>
</tr>
</table>
</main>

<footer align="right" >
<font color="#ffffff">
<br>&copy;MyLife 2021 &nbsp; &nbsp; &nbsp; &nbsp;
</font>
</footer>
</td></tr></table>
</body>
</html>

Completed Code profile.html

<IDOCTYPE html>
<html lang="en">

<head>
<meta charset="UTF-8">
<meta name="viewport" content="width=device-width, initial-scale=1.0">
<title>Prifile Ben</title>

</head>

<body bgcolor="#cccccc">
<h1>My Profile Page</hl>
<section>
<img src="../images/Ben.jpg" alt="Ben" height="200" />
<h2>About Me</h2>
<ul>
<li>Born in Boston</li>
<li>Live in Phily</1i>
<li>Like HTML</1i>
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<li>Helped write the Constitution</1i>

</ul>
</section>
<hr>
<section>
<h2>My Interests</h2>
<ol>
<li><i>Writing</i></1i>
<1li>Politics</1i>
<li>Flying <b>Kites</b></1i>
</ol>
</section>
<hr>
<section>
<h2>A song for you</h2>
<audio src="../media/Haydn_Adagio.mp3" controls>
<sub> Get a better browser...</sub>
</audio>
<audio controls>
<source src="../media/Haydn_Adagio.mp3" />
<source src="../media/Tchaikovsky Rococo_Var_orch.mp3" />
<sub> Get a better browser...</sub>
</audio>
</section>
<section>

<h2>Social Media</h2>
<a href="https://www.facebook.com/nucamp.co/" target="_blank">
<img src="../images/FB.jpg" alt="Facebook">
</a><br>
<iframe width="560" height="315" src="https://www.youtube.com/embed/6iuctWusI7w" title="YouTube video player" frameborder="0" allow=
"accelerometer; autoplay; clipboard-write; encrypted-media; gyroscope; picture-in-picture" allowfullscreen></iframe>
</section>
</body>
</html>



